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Texas Essential Knowledge and Skills 
Technology Applications Correlation 

 
A primary goal of these training modules for classroom teachers is to build their technology 
competencies as described and outlined in the Texas Essential Knowledge and Skills (TEKS) for 
Technology Applications, K-5 and 6-8. Obtaining this goal will better prepare the classroom teachers to 
incorporate these skills into their curriculum and instructional strategies. This course incorporates and 
introduces the following knowledge and skills: 

 
K-5 TEKS 
(2) Foundations. 
The student uses data input skills appropriate to the task. 
The student is expected to: 

(D) produce documents at the keyboard, proofread, and correct errors. 
 
(7) Solving problems. 
The student uses appropriate computer-based productivity tools to create and modify solutions to 
problems. 
The student is expected to: 

(A) use software programs with audio, video, and graphics to enhance learning experiences. 
(B) use appropriate software to express ideas and solve problems including the use of word 
processing, graphics, databases, spreadsheets, simulations, and multimedia. 
(C) use a variety of data types including text, graphics, digital audio, and video. 

 
(8) Solving problems. 
The student uses research skills and electronic communication, with appropriate supervision, to create 
new knowledge. 
The student is expected to: 

(A) use communication tools to participate in group projects. 
 
(10) Communication. 
The student formats digital information for appropriate and effective communication. 
The student is expected to: 

(A) use font attributes, color, white space, and graphics to ensure that products are appropriate 
for the defined audience. 
(B) use font attributes, color, white space, and graphics to ensure that products are appropriate 
for the communication media including multimedia screen displays, Internet documents, and 
printed materials. 

 
(11) Communication. 
The student delivers the product electronically in a variety of media, with appropriate supervision. 
The student is expected to: 

(A) publish information in a variety of media including, but not limited to, printed copy, 
monitor display, Internet documents, and video. 
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Texas Essential Knowledge and Skills 
Technology Applications Correlation 

 

 
6-8 TEKS 

 

 
(2) Foundations. 
The student uses data input skills appropriate to the task. 
The student is expected to: 

(D) develop strategies for capturing digital files while conserving memory and retaining image 
quality. 

 
(3) Foundations. 
The student complies with the laws and examines the issues regarding the use of technology in society. 
The student is expected to: 

(B) demonstrate proper etiquette and knowledge of acceptable use while in an individual 
classroom, lab, or on the Internet and intranet. 

 
(5) Information acquisition. 
The student acquires electronic information in a variety of formats, with appropriate supervision. 
The student is expected to: 

(A) identify, create, and use files in various formats such as text, bitmapped/vector graphics, 
image, video, and audio files. 

 
(7) Solving problems. 
The student uses appropriate computer-based productivity tools to create and modify solutions to 
problems. 
The student is expected to: 

(A) plan, create, and edit documents created with a word processor using readable fonts, 
alignment, page setup, tabs and ruler settings. 
(D) demonstrate proficiency in the use of multimedia authoring programs by creating linear or 
non-linear projects incorporating text, audio, video, and graphics. 
(E) create a document using desktop publishing techniques including, but not limited to, the 
creation of multi-column or multi-section documents with a variety of text-wrapped frame 
formats. 
(F) differentiate between and demonstrate the appropriate use of a variety of graphic tools found 
in draw and paint applications. 
(G) integrate two or more productivity tools into a document including, but not limited to, 
tables, charts and graphics, graphics from paint or draw programs, and mail merge. 
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Texas Essential Knowledge and Skills 
Technology Applications Correlation 

 

 
6-8 TEKS 

 

 
(8) Solving problems. 
The student uses research skills and electronic communication, with appropriate supervision, to create 
new knowledge. 
The student is expected to: 

(A) participate with electronic communities as a learner, initiator, contributor, and 
teacher/mentor. 
(C) use groupware, collaborative software, and productivity tools to create products. 
(D) use technology in self-directed activities by sharing products for defined audiences. 
(E) integrate acquired technology applications skills, strategies, and use of the word processor, 
database, spreadsheet, telecommunications, draw, paint, and utility programs into the 
foundation and enrichment curricula. 

 

 
(10) Communication. 
The student formats digital information for appropriate and effective communication. 
The student is expected to: 

(D) demonstrate appropriate use of fonts, styles, and sizes, as well as effective use of graphics 
and page design to effectively communicate. 

 

 
(11) Communication. 
The student delivers the product electronically in a variety of media, with appropriate supervision. 
The student is expected to: 

(B) design and create interdisciplinary multimedia presentations for defined audiences including 
audio, video, text, and graphics. 
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Publisher Ideas in the Curriculum 
 
 
Posters 
A quick easy start, you can introduce basics like: 

Inserting graphics from the web 
Picture placement and wrapping 
Changing fonts 
Word Art 
Web Research and Citation 
White space 

Curricular Uses 
Short biographies: Black History Month, historical novels, authors, students 
Background reports for a novel or time period in history 
More: 

 
 
 

Posters 
1. Open a new blank print publication 
2. Under Arrange, choose Layout Guides. 
3. Change all margins to .5”. 
4. To create text boxes, tables, Word Art or to insert pictures, 

lines or shapes use the tool bar. 
5. Use Word Art for headlines or titles. 
6. To create a border around a text box, go to the Format, 

Format Text Box. On the Colors and Lines tab, choose 
Border Art. 

7. If the design you want is not available in Available 
Borders list, choose the Create Custom button and Select 
Picture. This gives you access to all the Microsoft clipart 
installed on your computer searchable by keyword. 

8. You will need to adjust the weight to have an appropriately sized 
border. 

9. A picture border can also be added around a photo or other art 
by choosing the picture, then using the Format menu. The menu 
item will now read Format Picture. Follow steps 6-8 above. 

10. Items can be moved. Select an item then hover the mouse above 
the edge until the moving van appears. Click and hold on the 
edge and drag. Alternatively after clicking on the object, you can 
use the arrow keys to nudge an object. 
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Publisher Ideas in the Curriculum 
 
 
Flip Cards 
Beginning skills such as 

Word Art 
Inserting graphics 

Curricular Uses 
Flash cards (math, vocabulary, etc.) 
More: 

 
 
Flip Cards (half page style) 

1. Open a new blank print publication – click on Publication Tab, select 
      Full Page, click Create 
2. Under Arrange, Layout Guides, Margin Guides -  
 Change all Margin Guides to 0.5” 
3. Under Arrange, Layout Guides, Grid Guides - 
 Change to 2 rows  
4. For Tall Cards: 

a. Between steps 1 and 2: under File, Page Setup – change to 
Landscape 

b. Follow above except in step 5 use columns instead of rows. 
5. After the card is designed, the cards can be 

c. Printed single sided, folded and laminated 
d. Printed double sided and cut 

 
 
 
Flip Cards (quarter page style) 

1. Open a new blank print publication 
2. Under File, Page Setup – change to Landscape 
3. Under Arrange, Layout Guides, choose the Margin Guides tab. 
4. Change all Margin Guides to 0.5” 
5. Under Arrange, Layout Guides, choose the Grid Guides tab. 
6. Change to 2 rows and 2 columns with 1” spacing (gutter) 
7. After the card is designed, the cards can be 

a. Printed single sided, folded and laminated 
b. Printed double sided and cut 

 
 
 
Flip Cards General Hints 

 
 
There are 2 options for printing. 

1. print single sided, fold and laminate. 
2. print double sided on thick paper or card stock and cut. 

 

 
See also: http://www.microsoft.com/education/default.asp?ID=WordFlipper 
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Publisher Ideas in the Curriculum 
 
 
Bookmarks 
Advanced skills such as 

Columns, gutters 
Front/back 
Grouping/duplicating 
Practice: word art, borders, sizing graphics 

Curricular Uses 
Book reports, background reports 
Short reports, biographies, 
Endangered species/plants 
More: 

 
 
 
Book Marks 

1. Open a new blank print publication – click on Publication Tab, select 
      Full Page, click Create 
2. Under the File menu, open the Page Setup dialog box. At the 

bottom, change the Orientation to Landscape. 
3. Open the Arrange menu and the Layout Guides dialog box. 
4. Under Margin Guides, change all the margins to 0.2”. 
5. Under the Grid Guides, create 4 or 5 columns. 
6. If creating 2-sided book marks, Insert a Page. Just click OK to 

accept the defaults. 
7. Create one bookmark within one column. 
8. Group the items, then copy, paste and move into the other columns. 
9. If creating 2-sided book marks, repeat 7 & 8 on page 2 for the back. 
10. After the book marks are designed, print and cut. 

 
 
 
 
 
 
 
 
Book Marks Hints 

• Both 4 and 5 book marks per page give sufficient space without being too wide 
or too narrow. Choose by the number of students (if trading) or amount of 
information and graphics desired. 

• Encourage the use of frames and graphics. 
• If creating 2-sided book marks, practice with plain paper to test how the paper 

goes back into the printer before using the thicker paper or cardstock. 
• Test your printer. Some printers (especially ink jet) need a little room all 

around for rollers and a little more on the bottom that it just cannot print on. 
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Publisher Ideas in the Curriculum 
 
 
Trading Cards 
More complex skills such as 

Columns and rows 
Grouping/duplicating 
Review: text formatting, condensing information, white space 

Curricular Uses 
“hero” cards 
background research on historical novels or time periods 
More: 

 
 
Trading Cards 

1. Open a new blank print publication – click on  
      Publication Tab, select Full Page, click Create 
2. Open the Arrange menu and the Layout Guides dialog 

box. 
3. Under Margin Guides, change all the margins to 0.2”. 
4. Under the Grid Guides tab, create 3 columns and 3 rows.  
5. Insert a Page. Just click OK to accept the defaults. 
6. After the cards are designed, print and cut. See hints below. 

 
 
 
Trading Cards Hints 

• Have the students create either 1 or 3 or 9 different cards. 
 The same image on all the cards is by far the simplest and best  

        if trading. 
 When creating 3 different cards, have students do the same   

        image across the page. This makes it easier when creating the  
        back side. 

 When creating 9 different cards, review using a real paper how the  
        line up is opposite on the reverse side. 

• Practice with plain paper to test how the paper goes back into the 
printer before using the thicker paper or cardstock. 

• Find a rotary paper cutter rather than the long arm style and allow the 
kids to cut their own. 

• Test your printer. Some printers (especially ink jet) need a little room all around for rollers and a 
little more on the bottom that it just cannot print on. 
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Publisher Ideas in the Curriculum 
 
 
Mini-books 
Review of skills such as 

Word Art 
White space 
Continuity 

Curricular Uses 
Alphabet/number books 
People or places 
Fact or fiction 
“Select-A-Quest” (group project) 
Ask your Librarian about placing copies in the Library 
More: 

 
 
 
 
Mini-Books 

1. Open a new blank print publication – click on Publication Tab, select Full Page, click Create 
2. Open the Arrange menu and the Layout Guides dialog box. 
3. Under Margin Guides, Change all margins to 0.8”. You may want to increase the left      
      margin for binding. 
4. Under Arrange, Layout Guides, choose the Grid Guides. 
5. Change to 2 rows and 2 columns  
6. After the students have designed the book, make sure there are page numbers before you print 

and cut the book. 
7. Assemble the book in order and staple along the left margin. 

 
 
 
Mini-Books Hints 

• Binding can be done with a stapler. To make it a little fancier, cut colored paper in halves until 
you get a strip about 1.5” wide and as tall as the quarter page. Fold in half then fold the edges to 
the center. Insert pages into the center and staple. 

• Ask the Librarian if your class can share copies of their books in the Library. 
• Create books for a younger class. 
• Put in page numbers 
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Publisher Ideas in the Curriculum 
 
 
Brochures 
Use of the templates makes this a simple task. Used basic and advanced skills 

Working with pictures and captions 
Working with set space/dividing text into sections 
Uniform look and feel 

Curricular Uses 
Book reports or background report for a novel 
geography country reports 
Foreign language country or travel brochures 
Historical time period reports 
Any subject reports 
More: 

 
 
Brochures from Template 
In XP, use the New from Design in the New Publication task pane and choose one of the available 
brochures. 

 
 
Brochures from Scratch 

1. Open a new blank print publication – click on Publication Tab, select 
Full Page, click Create 

2. Under File, choose Page Setup. Select Landscape. 
3. Under Arrange, choose Layout Guides. 
4. On the Margin Guides, change all margins to .5”. 
5. On the Grid Guides, make three columns. The XP version 

also allows you to change the “gutter” or Spacing. Increase 
the spacing to .8”. 

6. Insert a new page (Insert / Page / accept defaults / click 
OK). To switch between pages, use the page icons at the 
bottom of the page. 

 
 
 
Brochures Hints 

• Always sketch out the design on a blank folder paper first.  
• Try a brochure using portrait setup. 
• Experiment with legal sized page in both tri- and quad-folds.  
• Emphasize the chunking of information. 
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Publisher Ideas in the Curriculum 
 
 
Newsletters 
More advanced skills such as 

Mastheads, headlines, subheadings, 
Styles 
Columns, continued stories, 
Captions 
Working within a set space 
Multi-page documents 

Curricular Uses 
Novel units, 
Local events 
More: 

 
 
 
Legal-Sized Folded Newsletters 

1. Open a new blank print publication – click on  
      Publication Tab, select Full Page, click Create 
2. Under File, Page Setup change the orientation to landscape  
3.   Under File, Print Setup change the paper size to legal 
4. Set up 7 columns under Arrange, Layout Guides. The center 

column will be the fold and margins leaving three for each 
page. 

5.   Insert a New Page. (Insert / Page / accept defaults / click 
OK). To switch between pages, use the page icons at the 
bottom of the page. 

 

 
 
 
 
 
 
Newsletters General Hints 

• Use an odd number of columns and mix the column widths. For example, with a 3-column 
underlying grid, you can use 2 columns for the main story and the other for pull quotes, 
pictures index or short stories. 

• Sketch the general design first.  
• Use Word Art for the masthead. 
• Write the stories in Word. It has better spelling and grammar applets. Import the story using the 
     File menu then Import Word Document or copy and paste into a text box. 
• Continuing columns: If the text overflows the current text box an A… will appear. You need 

to create the text box where the story will continue, then click back on the original box. In 
the tools bar click on the chain link. The cursor then turns into a cup. Move to the target box 
and click. 


